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About This Guide

The NetIQ® AppManager® Suite (or AppManager) is a comprehensive solution for managing, 
diagnosing, and analyzing the performance, availability, and server health for a broad spectrum of 
operating environments, applications, and server hardware.

AppManager enables system administrators to view all of their servers and workstations from a 
central, easy-to-use console, providing complete visibility of critical server and application resources 
across the enterprise. With AppManager, administrative staffs can monitor computer and application 
resources, check for potential problems, initiate responsive actions, automate routine tasks, and 
gather performance data for real-time and historical reporting and analysis.

Intended Audience
This management guide explains how to successfully use AppManager and Vivinet Diagnostics to 
diagnose problems with voice over IP and call quality. 

For more information about working with AppManager, see the User Guides for the Operator 
Console or Control Center. For more information about configuring and maintaining an 
AppManager management site, see the Administrator Guide.

Conventions
This guide uses consistent conventions to help you identify items throughout the documentation. 
The following table summarizes these conventions.

Convention Use

Bold  Window and menu items

 Technical terms, when introduced

Italics  Book and installation kit titles

 Variable names and values

 Emphasized words

Fixed Font  File and folder names

 Commands and code examples

 Text you must type

 Text (output) displayed in the command-line interface
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Using Online Help
AppManager provides task-based, reference, and context-sensitive online Help.

To access task-based Help or search for Help topics, click Help Topics on the Help menu. To view 
context-sensitive Help within dialog boxes, click Help or press F1.

You can get help on individual Knowledge Scripts in one of the following ways:

 On the Values tab of the Knowledge Script Properties dialog box, click Help or press F1.
 In the Knowledge Script pane of the Operator Console, highlight a Knowledge Script and press 

F1.
 In the Knowledge Script view of the Control Center Console, highlight a Knowledge Script and 

press F1.

Other Information in the Library

The library provides the following information resources:

 Installation Guide: Provides complete information about AppManager pre-installation 
requirements and step-by-step installation procedures for all AppManager components.

 Control Center User Guide: Provides complete information about managing groups of computers, 
including running jobs, responding to events, creating reports, and working with the Control 
Center Console. A separate guide is available for the AppManager Operator Console.

 Administrator Guide: Provides information about maintaining an AppManager management site, 
managing security, using scripts to handle AppManager tasks, and leveraging advanced 
configuration options.

 Upgrade and Migration Guide: Provides complete information on how to upgrade from a previous 
version of AppManager.

 Management Guides: Provide information about installing and monitoring specific applications 
with AppManager.

The AppManager library is available in Adobe Acrobat (PDF) format and is located in the 
\Documentation folder of the AppManager installation kit.

NetIQ Online Support and Extended Support Web sites provide other resources:

 Downloads, including hotfixes, service packs, and product upgrades.
 Documentation, including white papers and the most current information about version support 

for the systems and applications monitored by AppManager.

NOTE: You can access NetIQ Support without a password or registration. To access the Extended 
Support site, you must be a registered AppManager customer.

In addition to the AppManager documentation, you may want to consult the documentation for your 
Windows or UNIX operating system, or other application- or system-specific documentation for 
reference and conceptual information. This background information can help you get the most out of 
your AppManager installation.
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About Attachmate

Attachmate, owned by an investment group led by Francisco Partners, Golden Gate Capital and 
Thomas Cressey Equity Partners, enables IT organizations to extend mission critical services and 
assure they are managed, secure and compliant. Attachmate’s leading solutions include host 
connectivity, systems and security management, and PC lifecycle management. Our goal is to 
empower IT organizations to deliver trusted applications, manage service levels, and ensure 
compliance by leveraging knowledge, automation and secured connectivity. For more information, 
visit www.attachmate.com.

NetIQ Solutions from Attachmate
Attachmate provides a wide selection of systems and security management solutions to help you 
manage and secure all your essential platforms, including Windows, UNIX, Linux, and iSeries. These 
Knowledge-Based Service Assurance products and solutions include embedded knowledge and 
tools to implement industry best practices and to better ensure operational integrity, manage service 
levels and risk, and ensure policy compliance. Our modular, best-of-breed solutions for Performance 
and Availability Management, Security Management, Configuration and Vulnerability Management, 
and Operational Change Control integrate through an open, service-oriented architecture allowing 
for common reporting, analytics and dashboards. Attachmate offers the following systems and 
security management solutions:

 Performance and Availability Management These products offer rapid time-to-value solutions 
that enable you to align your IT operations with business priorities and optimize the delivery of 
your IT-based business services. This solution automates the complete IT service management 
lifecycle: assessment of requirements, definition of Service Level Agreements, management of 
day-to-day operations, and review of operational metrics.

 Security Management These easy-to-install-and-deploy products provide effective protection 
from and response to security-related threats. This solution provides powerful features, such as 
real-time security event monitoring, mapping of threat indicators, policy violation alerts, and 
expedited incident forensics and resolution. These products reduce the time required to identify 
and resolve security threats.

 Configuration and Vulnerability Management These products allow you to quickly and easily 
assess vulnerabilities, manage security risks, and assure policy compliance. This powerful 
solution measures and enforces compliance to configuration baselines based on your corporate 
policies, regulations, and evolving security threats. You can use the latest security knowledge, 
which is updated in real time, to resolve compliance and configuration issues.

 Operational Change Control These products enable IT organizations to control, manage, and 
audit operational changes to servers, Active Directory, and Group Policy with unprecedented 
levels of accountability. NetIQ’s Operational Change Control (OCC) solutions enable enterprise 
customers to meet IT compliance and operational integrity needs in the most cost-effective 
manner, by delegating access control, managing changes according to policy, and alerting and 
reporting on change activities and entitlements.
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Contacting NetIQ Solutions Support
Please contact us with your questions and comments. We look forward to hearing from you.

Sales Email: info@netiq.com

Telephone: 713.418.5555 (United States) 
+353 (0) 91 782 677 (Europe, Middle East, and Africa)
For other locations, see our Support Contact Information Web site at 
www.netiq.com/support

Support Web Site: www.netiq.com/support
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1 1Integrating Vivinet Diagnostics with 
AppManager

This management guide discusses how you can use NetIQ Vivinet Diagnostics and NetIQ 
AppManager to diagnose problems with Voice over IP and call quality. The following topics are 
covered:

 Section 1.1, “Brief Overview,” on page 9
 Section 1.2, “What is Vivinet Diagnostics?,” on page 10
 Section 1.3, “How the Integration Works,” on page 10
 Section 1.4, “Integration Prerequisites,” on page 14
 Section 1.5, “Integration Configuration,” on page 14
 Section 1.6, “Parameters for Action_DiagnoseNortelIPT,” on page 15
 Section 1.7, “Parameters for Action_DiagnoseVoIPQuality,” on page 16
 Section 1.8, “Diagnosis Triggers,” on page 16
 Section 1.9, “Deleting Expired Reports,” on page 19
 Section 1.10, “Troubleshooting the Integration,” on page 19

1.1 Brief Overview
NetIQ AppManager includes Knowledge Scripts that monitor and detect problems with voice over 
IP (VoIP) quality and call quality. These scripts raise informational events as a result of the detected 
problems. The integration of Vivinet Diagnostics with AppManager provides the means to diagnose 
more precisely any problems with VoIP quality between phones, Performance Endpoints, or other 
target devices such as routers and gateways. 

Using a methodology that already exists (triggering an Action script based on an event), the 
integration of AppManager and Vivinet Diagnostics involves two Action scripts — 
Action_DiagnoseVoIPQuality and Action_DiagnoseNortelIPT — which trigger Vivinet Diagnostics to 
diagnose the problem for events raised by any of the following Knowledge Scripts:

 CiscoCallMgr_CallQuality. Vivinet Diagnostics can diagnose the problem when jitter, latency, 
and percentage of lost data exceed their thresholds.

 CiscoCallMgr_CallFailures. Vivinet Diagnostics can diagnose the problem when the number of 
failed calls exceeds its threshold.

 PhoneQuality_CiscoPhoneQuality. Vivinet Diagnostics can diagnose the problem when the 
values for listening MOS and listening R-value fall below their thresholds, and when the values 
for average jitter, maximum jitter, and packet loss exceed their thresholds.
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 VoIPQuality_CallPerf_<name of codec>. Vivinet Diagnostics can diagnose the problem when 
MOS, R-Value, delay, jitter, jitter buffer loss, and percentage of lost data exceed their thresholds.

 NortlCS_Alarms. Vivinet Diagnostics can diagnose the call quality problem that is identified by 
the QoS0028 alarm.

NOTE

 For a more in-depth discussion of the information in a script that triggers a Diagnosis, see 
Section 1.8, “Diagnosis Triggers,” on page 16.

 Vivinet Diagnostics must be installed on the computer on which the action is run.

1.2 What is Vivinet Diagnostics?
NetIQ Vivinet Diagnostics diagnoses problems with the routing, connections, and performance of 
voice over IP (VoIP) telephone calls on your network. With the data you receive from a Diagnosis, 
you can quickly resolve problems with VoIP hardware and software and improve the performance of 
voice over IP.

Vivinet Diagnostics is designed to perform two primary functions:

 Diagnose and locate the source of problems you detect on your network, such as poor-quality 
voice transmissions, dropped calls, or cutouts.

 Analyze the path a particular call actually takes through your network, including routers, 
switches, or voice gateways that intervene between the caller and called party.

Vivinet Diagnostics helps you diagnose and remedy problems on your voice over IP network by 
gathering data from network devices and measuring simulated VoIP traffic. To pinpoint the source of 
a problem, it also runs a path trace between two selected nodes on the network. 

Vivinet Diagnostics contains a Knowledge Engine that stores data collected on your network from each 
Diagnosis you run. The Knowledge Engine compares the data it collects to its own information about 
voice over IP, network hardware and software, and typical VoIP trouble spots to analyze and 
diagnose a problem you report. The Knowledge Engine stores and analyzes the data gathered from 
your network and then uses it to generate a diagnostic report after a Diagnosis has run. 

As the Diagnosis runs, Vivinet Diagnostics sends simulated VoIP traffic between selected endpoints 
or phones (the same phones or endpoints for which AppManager detected problems) and shows you 
a path trace indicating exactly how the traffic is traveling from Point A to Point B. Vivinet Diagnostics 
takes measurements, checks call data records from VoIP network software, and uses its Knowledge 
Engine to arrive at a Diagnosis. A diagnostic report helps you analyze the problem and respond 
appropriately. 

1.3 How the Integration Works
When you run one of the applicable monitoring Knowledge Scripts, Vivinet Diagnostics can diagnose 
the problem should any VoIP or call quality parameter exceed its threshold. AppManager uses 
Action scripts — DiagnoseVoIPQuality and DiagnoseNortelIPT — to invoke Vivinet Diagnostics. 

The Diagnose Action scripts use an interface to Vivinet Diagnostics to define the parameters of the 
Diagnosis, run the Diagnosis, and save the results. The parameters used to define the Diagnosis are 
taken from the monitoring script that raised the event. The thresholds in the scripts correspond to the 
marginal/poor thresholds in Vivinet Diagnostics. Results are saved in Vivinet Diagnostics Diagnosis 
files, which have a file extension of .dgv. 
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NOTE: If the AppManager Report agent is installed on the same computer on which the Diagnose 
Action scripts run, then you use the Report agent settings, which allow the Diagnosis results to be 
integrated with the AppManager Report Binder. 

Upon completion of the Diagnosis, AppManager raises an event that contains the results of the 
Diagnosis. An event for an unsuccessful Diagnosis contains an error message explaining why the 
Diagnosis was unsuccessful. In an event message for a successful Diagnosis, the Message tab contains 
one of the following:

 A URL to an HTML report, if the AppManager Report agent is installed on the computer on 
which the Diagnosis was run

 Computer name and full path of the location of the output files, if the AppManager Report agent 
is not installed on the computer on which the Diagnosis was run

The HTML report contains a hyperlink to the Vivinet Diagnostics Diagnosis file, and, if you are 
running Vivinet Diagnostics 2.1 or later, a hyperlink to an HTML summary report of the Diagnosis. 

In this example, the first hyperlink provides access to the .dgv Diagnosis file in the Vivinet 
Diagnostics Console. The second hyperlink provides access to the HTML summary report.

 Section 1.3.1, “Reviewing the Diagnosis File,” on page 12
 Section 1.3.2, “Reviewing the HTML Summary Report,” on page 13
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1.3.1 Reviewing the Diagnosis File

When you click on the hyperlink for the Diagnosis .dgv file, the Vivinet Diagnostics Console opens to 
the Define tab, which displays the parameters of the Diagnosis. 

Depending on your browser settings, the Console will open or you will be given the option to “Save” 
or “Open the file.” Opening the file will launch the Vivinet Diagnostics Console.

Click the Report tab of the Vivinet Diagnostics Console to see the results of the Diagnosis.

When you open the Diagnosis file directly from the Web server, Internet Explorer makes a copy of the 
file in your Temporary Internet Files folder. If you click Save in Vivinet Diagnostics, this copy is 
updated. If you modify the Diagnosis parameters or rerun the Diagnosis, we recommend that you 
use Save As to save the file in a different folder.

For more detailed information about understanding Vivinet Diagnostics reports, see the Vivinet 
Diagnostics User Guide.
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NOTE

 You can launch the Vivinet Diagnostics Console from the Extensions > Launch Vivinet 
Diagnostics menu in the AppManager Operator console. 

 When the Report agent is being used for creating Diagnoses, you can see all completed 
Diagnoses by launching the AppManager Report Binder, which you can access from the 
AppManager Operator Console: Extensions > Report Viewer.

1.3.2 Reviewing the HTML Summary Report

For Vivinet Diagnostics version 2.1 or later, AppManager generates a summary report of the 
Diagnosis in HTML format, and saves it in the same location as the Diagnosis file discussed in 
Section 1.3.1, “Reviewing the Diagnosis File,” on page 12.

The summary report provides the same information as the Diagnosis file, without the need to open 
the Vivinet Diagnostics Console. 

The Problem Summary section identifies the parameter settings from the Define tab, as well as 
thresholds and settings from the Options menu selections, such as QoS definitions and call quality 
thresholds.

The Path Trace section provides a graphical representation of the outgoing and incoming path taken 
by the Diagnosis. This is the same representation you see on the Diagnose tab of the Console.

The Results and Diagnosis sections present the same information you find on the Report tab.

The remaining sections in the HTML summary vary depending on the types of devices represented 
in the path trace, such as Device Details and Link Details. But all information in these sections is 
available in the Console by right-clicking on a device icon in the path trace on the Diagnose tab.

For more information, see the Vivinet Diagnostics User Guide.
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1.4 Integration Prerequisites
The computer on which the Action script runs requires the following:

 Licensed version of Vivinet Diagnostics: 
 Version 1.1 or later to run Action_DiagnoseVoIPQuality
 Version 2.0 or later to run Action_DiagnoseNortelIPT 
 Version 2.1 or later to export Diagnosis summary reports in HTML format 

 Microsoft XML Parser version 3 or Internet Explorer 5.5 SP2 or later

In addition, AppManager assumes that you have already configured Vivinet Diagnostics with global 
settings for CallManager, SQL passwords, and SNMP community strings, and security information 
for accessing your Nortel Call Servers and Signaling Servers. For more information, see the Vivinet 
Diagnostics User Guide.

1.5 Integration Configuration
This section discusses the two ways in which you can configure AppManager to work with Vivinet 
Diagnostics

 Section 1.5.1, “Diagnostics and AppManager on One Computer,” on page 14
 Section 1.5.2, “Diagnostics and AppManager on Separate Computers,” on page 14

1.5.1 Diagnostics and AppManager on One Computer

The most common configuration is one in which the AppManager server components (repository, 
management server, Web management server, consoles, and agent, including the Report agent) are 
installed on a single computer. Vivinet Diagnostics is installed on this same computer. Installing both 
applications on the same computer allows the Diagnose Action scripts to run on the management 
server computer, which is the default location. In addition, having both applications on the same 
computer allows the integration of the Diagnosis results with the AppManager Report Binder and 
Web management server.

1.5.2 Diagnostics and AppManager on Separate Computers

An alternative configuration is one in which Vivinet Diagnostics, the AppManager agent (including 
the Report agent), and the AppManager consoles are installed on a computer that is remote from the 
computer on which the AppManager repository, management server, and Web management server 
are installed. 

In this configuration, you must configure DiagnoseVoIPQuality and DiagnoseNortelIPT to run on the 
remote, or proxy, computer. 

To configure the script to run on a proxy computer:

1 In the Properties dialog box of the Monitoring script, click the Actions tab. 
Action_DiagnoseVoIPQuality is selected by default.

2 Click in the Location field and select Proxy from the drop list that appears. The Computer 
Browser dialog box is displayed.
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3 Select the computer on which Vivinet Diagnostics and the AppManager agent are installed, and 
then click OK.

4 Continue entering information on the other tabs, or click OK to start the monitoring job.

If you are running Vivinet Diagnostics 2.0 or earlier, we recommend that you purchase and install 
Vivinet Diagnostics on each computer on which you have installed an AppManager Operator 
Console. Having the Console and Vivinet Diagnostics on the same computer allows you to view the 
Vivinet Diagnostics report as well as rerun the Diagnosis. 

For Vivinet Diagnostics 2.1 or later, access to the Vivinet Diagnostics Console is not required because 
AppManager generates a summary report in HTML format. All that is required is access to the 
directory in which the summary report is saved. However, access to the Console is necessary if you 
want to be able to rerun a Diagnosis. 

For more information, see Section 1.3.2, “Reviewing the HTML Summary Report,” on page 13.

1.6 Parameters for Action_DiagnoseNortelIPT
Use the following guidelines for configuring the parameters on the Values tab of the 
Action_DiagnoseNortelIPT Knowledge Script:

Parameter How To Set It

Output folder prefix Enter a prefix for the output folder that is generated by the diagnosis. 
The output folder then uses this prefix in the following naming 
convention: Prefix_JobID_Phone1_Phone2_DateTime. 

The default prefix is Diag. Phone1 and Phone2 are the IP addresses of 
the Nortel phones being diagnosed.

Use Report Agent settings? Set to y to specify that the Diagnostic results should be integrated into 
the AppManager Web management server (the Report Binder). The 
default is y.

Full path to root of output folders Enter the full UNC path to the root of where the output folder(s) will be 
created. 

Make sure that the NetIQmc service (NetIQ AppManager Client 
Resource Monitor) is configured to run as a user that has access to the 
UNC path. The default setting of  “local system” does not have access to 
the UNC path. Without access to the path, Vivinet Diagnostics will not be 
able to save a Diagnosis to the output folder.

NOTE: This parameter is ignored if Use Report Agent settings is set to 
y.

Event severity when … Set the severity level, between 1 and 40, to indicate the importance of 
the following events:

… error. Raises an event when the diagnosis does not complete 
successfully. The default is 15.

… successful. Raises an event when the diagnosis completes 
successfully. The default is 35.
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1.7 Parameters for Action_DiagnoseVoIPQuality
Use the following guidelines for configuring the parameters on the Values tab of the 
Action_DiagnoseVoIPQuality Knowledge Script.

1.8 Diagnosis Triggers
The following topics discuss in detail each of the monitoring scripts for which you can use an Action 
script to trigger a Diagnosis.

 Section 1.8.1, “CiscoCallMgr_CallQuality,” on page 17
 Section 1.8.2, “CiscoCallMgr_CallFailures,” on page 17
 Section 1.8.3, “NortelCS_Alarms,” on page 18
 Section 1.8.4, “PhoneQuality_CiscoPhoneQuality,” on page 18
 Section 1.8.5, “VoIPQuality_CallPerf,” on page 18

Parameter How To Set It

Event severity when … Set the severity level, between 1 and 40, to indicate the importance of 
the following events:·

… error. This script raises an event when the Diagnosis does not 
complete successfully.

… successful. This script raises an event upon successful completion of 
the action (Diagnosis).

Output folder prefix Enter a prefix for the output folder that is generated by the Diagnosis. 
The output folder naming convention is as follows:

<user-defined prefix>_<JobID>_<name of CallManager 
computer OR talker/listener>_<DateTime><0|1|2|3|4>

NOTE: <0|1|2|3|4> is appended only if a single event triggers 
multiple diagnoses. 

The output folder will contain the .dgv file, the diagnostic .html report 
file, and, if integrated with the Report Agent, a 
default.rptIndex.xml file and a default.htm file that contains 
hyperlinks to both the .dgv file and the diagnostic .html report.

Use Report Agent settings? Set to Yes to specify that the Diagnostics results should be integrated 
into the AppManager Web management server (the Report Binder). To 
use this option, the Report Agent must be installed on the computer on 
which you run Action_DiagnoseVoIPQuality.

Full path to root of output folders Enter the full path to the root of where the output folder(s) will be 
created. 

NOTE: This parameter is ignored if Use Report Agent settings is set to 
Yes.

Maximum diagnoses Enter a number between 1 and 5 to indicate the maximum number of 
diagnoses that can be triggered by a single event. 

This parameter is applicable only for events raised by 
CiscoCallMgr_CallQuality and CiscoCallMgr_CallFailures, where one 
event may identify multiple pairs of phones that indicate a problem.
16 Integrating NetIQ AppManager with NetIQ Vivinet Diagnostics



1.8.1 CiscoCallMgr_CallQuality

The CiscoCallMgr_CallQuality Knowledge Script monitors the Cisco CallManager CMR (call 
management record) database for calls for which poor VoIP quality metrics were recorded. This 
script runs periodically and looks at all calls that were generated since the last time the script ran. If 
any call falls in the “poor” category, then the script raises an event. If multiple calls exhibit poor 
quality, then the event detail message may contain information for multiple pairs of phones (up to 
50).

CiscoCallMgr_CallQuality detects the following VoIP quality conditions:

 Jitter exceeds the threshold
 Latency exceeds the threshold
 Percentage of lost data exceeds the threshold

An event raised by this script will trigger a Vivinet Diagnostics Diagnosis between two phones. 
Vivinet Diagnostics uses the following information when generating a Diagnosis:

 Phone 1 and Phone 2, which are IP telephones or traditional telephones (POTS phones) on the 
PSTN. Either Phone 1 or Phone 2 must be an IP phone.

 Time problem occurred, which is specified as unknown, 5, 10, 15, 30, 60, or 90 minutes ago. The 
time is based on the schedule of the Monitoring script.

 Thresholds, which are specified below. Diagnostics defaults will be used for any threshold not 
specified.
 Delay, measured in ms, set to the value of the Maximum acceptable latency parameter in the 

Knowledge Script.
 Lost data, measured in %, set to the value of the Maximum acceptable percentage lost data 

parameter in the Knowledge Script.

1.8.2 CiscoCallMgr_CallFailures

The CiscoCallMgr_CallFailures Knowledge Script monitors the Cisco CallManager CDR (call detail 
record) and CMR (call management record) databases, looking at the termination codes for all calls. 
This script runs periodically and looks at all calls terminated since the last time the script ran. If any 
call contains an abnormal termination code, then the script raises an event. If multiple calls contain 
abnormal termination codes, then the event may contain information for multiple pairs of phones (up 
to 50).

CiscoCallMgr_CallFailures detects conditions in which the number of abnormally terminated calls 
exceeds the value you set in the Maximum failed calls threshold.

An event raised by this script will trigger a Vivinet Diagnostics Diagnosis between two phones. 
Vivinet Diagnostics uses the following information when generating a Diagnosis:

 Phone 1 and Phone 2, which are IP telephones or traditional telephones (POTS phones) on the 
PSTN. Either Phone 1 or Phone 2 must be an IP phone.

 Time problem occurred, which is specified as unknown, 5, 10, 15, 30, 60, or 90 minutes ago. 

NOTE: No call quality threshold information is configured in the CallFailures script, therefore the 
Vivinet Diagnostics defaults will be used.
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1.8.3 NortelCS_Alarms

This Knowledge Script monitors the Nortel CS1000 proxy agent for Nortel CS1000 alarms. Signaling 
Servers, VGMCs, and Media Gateways send alarms to the proxy agent using SNMP traps. One 
particular alarm, QoS0028, triggers Action_DiagnoseNortelIPT to invoke Vivinet Diagnostics. 

The QoS0028 alarm indicates that the R-value has exceeded the configured threshold.

An event raised by this script will trigger a Vivinet Diagnostics Diagnosis between two Nortel Phase 
2 IP phones.

1.8.4 PhoneQuality_CiscoPhoneQuality

The PhoneQuality_CiscoPhoneQuality Knowledge Script polls Web-enabled Cisco IP phones for 
voice quality statistics on active calls. when an active call is detected, this script collects or calculates 
the following call quality metrics:

 Jitter
 Percent packet loss
 MOS
 R-value

If, while AppManager is polling an IP phone, any call quality metric falls below or exceeds a 
threshold, then AppManager raises an event while the call is active. However, AppManager will 
raise only one event per call.

For instance, if the jitter threshold is crossed, then AppManager will raise an event. If, 30 seconds 
later during the same call, the MOS threshold is crossed, AppManager will not raise another event.

An event raised by this script will trigger a Vivinet Diagnostics Diagnosis between two IP phones. 
Vivinet Diagnostics uses the following information when generating a Diagnosis:

 Phone 1 and Phone 2, which are Web-enabled IP telephones.

 Time problem occurred, which is specified as unknown, 5, 10, 15, 30, 60, or 90 minutes ago. 

1.8.5 VoIPQuality_CallPerf

The VoIPQuality_CallPerf Knowledge Scripts monitor VoIP quality by periodically driving synthetic 
VoIP traffic between two NetIQ Performance Endpoints. Although this script can be run on a matrix 
of endpoints, a separate event is raised for each pair, if needed. For example, if the script is 
configured with two talkers and two listeners (for a total of four endpoint pairs), and two of these 
pairs have unacceptable MOS values, then two events will be raised. 

VoIPQuality_CallPerf scripts detect the following conditions:

 MOS or R-value that is below minimal acceptable threshold
 Delay that exceeds the threshold
 Jitter that exceeds the threshold
 Percentage of lost data that exceeds the threshold
 Percentage of loss due to jitter buffer that exceeds the threshold
 Test that failed to run
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An event raised by this script will trigger a Vivinet Diagnostics Diagnosis between two endpoints. 
Vivinet Diagnostics uses the following information when generating a Diagnosis:

 Endpoint 1 and Endpoint 2, the talker and caller, respectively, that were used in the VoIP test. 
Diagnostics uses the endpoints’ IP addresses or DNS hostnames.

 Script parameters, as listed below:
 Codec, from the configuration parameter (G.711a, G.711u, G.723.1-ACELP, G.723.1-

MPMLQ, G.726, G.729, or G.729A)
 Packet loss concealment
 Silence suppression
 Delay between voice datagrams, in milliseconds
 Service quality
 Jitter buffer size, in milliseconds
 Additional fixed delay, in milliseconds

NOTE: The Voice Activity Rate parameter in AppManager cannot be set when triggering a 
Diagnosis. Therefore, the Vivinet Diagnostics default of 50% is used when generating a 
Diagnosis.

 Target port, from the Destination port parameter in the Knowledge Script
 Threshold, as listed below:

 MOS, set to the Minimum acceptable MOS parameter, or R-value, set to the Minimum 
Acceptable R-value parameter in the Knowledge Script. Vivinet Diagnostics does not display 
the R-value metric. When a Diagnosis with R-value thresholds is triggered, Vivinet 
Diagnostics translates these thresholds into their equivalent MOS values.

 Delay, measured in milliseconds, set to the Maximum acceptable delay parameter in the 
Knowledge Script.

 Lost data, measured in percentage, set to the Maximum acceptable percentage lost data 
parameter in the Knowledge Script.

 Loss due to jitter buffer, measured in percentage, set to the Maximum acceptable percentage 
jitter buffer loss parameter in the Knowledge Script.

1.9 Deleting Expired Reports
A new Diagnosis result file is generated for each Diagnosis triggered by the Diagnose Action scripts. 
These files can build up over time — you should consider implementing a process to occasionally 
delete these files. 

If you are using the Report agent setting when generating the Diagnosis results, then we recommend 
that you use the AMAdmin_DeleteExpired Reports Knowledge Script to automatically delete old 
reports. Reports generated as a result of the Diagnose Action scripts are set by default to expire after 
60 days.

1.10 Troubleshooting the Integration
The following are some common problems that you may encounter when integrating Vivinet 
Diagnostics and AppManager.
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You received an error message indicating that Action_DiagnoseVoIPQuality will not run.  
Ensure that Vivinet Diagnostics version 1.1 (or later) is installed on the computer on which the 
Action script is to run. That same computer requires Microsoft XML Parser version 3 or Internet 
Explorer 5.5 SP2 or later.
In addition, you must register your version of Vivinet Diagnostics before the integration with 
AppManager will work.

You ran the Diagnosis, but cannot view the Diagnostic report from a different computer.  
Ensure that Vivinet Diagnostics version 1.1 or 2.0 is installed on the computer from which you 
are trying to view the Diagnostics Report. If additional AppManager Operator Consoles are 
installed for remote computers, we recommend that you purchase and install Vivinet 
Diagnostics on these computers as well. Installing both the Operator Console and Diagnostics on 
the same computer allows you to view the Diagnostic report as well as rerun the Diagnosis.

NOTE: With Vivinet Diagnostics 2.1, you can view an HTML summary report from a different 
computer. For more information, see Section 1.3.2, “Reviewing the HTML Summary Report,” on 
page 13.

The Diagnosis results indicate that Vivinet Diagnostics cannot resolve the phone or query SNMP 
information.  

If Vivinet Diagnostics cannot resolve phone or SNMP information, you will see a Log Viewer 
when you attempt to open the Diagnosis file (.dgv). The Log Viewer displays the error 
messages. In addition, if there is an error, then the Vivinet Diagnostics Console will not display 
results when you click the Report tab.
Ensure that you have configured Vivinet Diagnostics with the CallManager names and 
passwords as well as the SNMP community strings for querying SNMP information from 
routers. 
If you had not configured this information prior to running the Diagnosis, do so now, and then 
rerun the Diagnosis by clicking the Diagnose tab on the Vivinet Diagnostics Console.
You need only configure the CallManager and SNMP information once. Vivinet Diagnostics will 
continue to use the information for subsequent Diagnoses.

AppManager raised several call-quality events, but Vivinet Diagnostics ran only one Diagnosis.  
So that the Action script can trigger Vivinet Diagnostics to run a diagnosis as often as a problem 
occurs, you need to disable or modify the “event collapsing” feature on the Alarms script. Event 
collapsing allows AppManager to suppress, or collapse, what it considers to be duplicate events. 
However, you will probably want Vivinet Diagnostics to diagnose a problem each time one 
occurs, even if it occurs between the same two targets. And you cannot do that if AppManager 
has collapsed all call quality events between the same targets into one event. Use the Advanced 
tab of the Alarms script to disable event collapsing, or at least to shorten the 20-minute 
collapsing interval.
To disable or modify event collapsing:

1. Click the Advanced tab.
2. To disable event collapsing, click to uncheck Collapse duplicate events into a single event.
3. To shorten the collapsing interval, select a smaller number in the Time interval for event 

collapsing field.
4. Stop and then restart the Knowledge Script job so that your changes are activated.
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You receive a 404 error message when attempting to open a .dgv file that is housed on Windows 
2003 Server.  

Tightened security of IIS in Windows Server 2003 prohibits the opening of unrecognized MIME 
types. You need to configure Windows Server 2003 to recognize the .dgv extension.

1. On the Windows Server 2003 computer, right-click My Computer and select Manage.
2. Expand Services and Applications.
3. Expand Internet Information Service.
4. Expand Web Sites.
5. Right-click on the Web site in question (you may have several) and select Properties. The 

Properties dialog box appears.
6. Click the HTTP Headers tab.
7. Click the MIME Types button. The MIME Types dialog box is displayed.
8. Click the New button.
9. In the Extension field, type .dgv.

10. In the MIME type field, type application/octet-stream.
11. Click OK to return to the MIME Types dialog box.
12. Click OK to return to the Properties dialog box.
13. Click OK or Apply to complete the change.

NOTE: You may need to stop and restart the Web site before the change takes effect.
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